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Introduzione  
 

. Sono aumentate nel tempo sia la risoluzione spaziale che la risoluzione temporale con le quali i dati si rendono 
disponibili agli utenti. Non a caso si parla spesso di big data satellitari, proprio in riferimento alla grande mole di 

dati potenzialmente utilizzabili per l’estrazione di informazioni utili.  

Affinché questi dati possano esprimere tutto il loro valore è necessario trovare delle soluzioni tecnologiche che 
permettano di estrarre in tempi brevi le informazioni, mediante dei processi automatizzati di elaborazione dei 
dati. Chi lavora con dati geospaziali in maniera tradizionale è infatti spesso costretto ad impiegare molto tempo 
in operazioni ripetitive (download dei dati, l’elaborazione attraverso molteplici software, ecc.) che sottraggono 
tempo ad attività di maggiore valore come l’analisi dei risultati ottenuti, fondamentale per l’adozione di decisioni. 

La soluzione a questo problema è costituita creazione di flussi di lavoro automatizzati, che assicurino risultati 
standardizzati e ripetibili. Lo Spatial Modeler di ERDAS IMAGINE consente di modellare operazioni di 
geoprocessing, anche complesse, attraverso procedure personalizzate e ripetibili, consentendo all'utente di 
costruire dei workflow personalizzati per l'elaborazione delle immagini.  

Nel tutorial vengono presentati alcuni casi applicativi che guideranno l’utente nella costruzione di modelli 
personalizzati, nella valorizzazione dei modelli già costruiti, disponibili in ERDAS IMAGINE e/o scaricabili 
gratuitamente dal web. Inoltre il tutorial presenta una guida passo-passo per la trasformazione dei propri algoritmi 
costruiti con lo Spatial Modeler in pulsanti personalizzati all’interno della toolbar di ERDAS IMAGINE. 

Il tutorial è corredato da un dataset di dati demo che permette di seguire con facilità i vari passaggi (file 
“Webinar_Planetek_14_10_16.zip”). 
 
ERDAS IMAGINE, potente suite software della Hexagon Geospatial, fornisce strumenti professionali di rapido e 
semplice utilizzo per gestire immagini satellitari, e permette di valorizzare al massimo le informazioni dei dati 
satellitari open semplificando le operazioni di classificazione, ortorettifica, mosaicatura, riproiezione, 
fotointerpretazione, change detection ecc. 

 
 

 
 

http://geospatialnews.planetek.it/2015/09/spatial-modeler-un-nuovo-strumento-per.html
http://www.planetek.it/prodotti/tutti_i_prodotti/erdas_imagine
http://www.hexagongeospatial.com/


 

GEOXPERIENCE ACCADEMY - HEXAGON GEOSPATIAL SOFTWARE 

 4 

PK01-528-579 

Costruzione guidata di alcuni modelli  
 

In questa esercitazione si utilizzerà lo Spatial Modeler al fine di creare graficamente un workflow per il 

processamento di dati Sentinel-2 per il cacolo di alcuni indici di vegetazione. 

Gli indici di vegetazione scaturiscono dallo studio del comportamento spettrale della vegetazione. E’ stata definita, 
in letteratura, una serie di relazioni quantitative fra i dati telerilevati e i parametri della vegetazione, mediante indici 
che si basano sul rapporto tra alcune bande spettrali specifiche (soprattutto sulle lunghezze d’onda del Rosso e 
dell’ Infrarosso).  

Per questa parte del tutorial verrà utilizzato il dato: 

S2A_OPER_PRD_MSIL1C_PDMC_20160702T171833_R079_V20160702T095806_20160702T095806.SAFE  
 
disponibile nella cartella 01_SENTINEL_2 del dataset associato al tutorial. 

 

I nomi dei file e delle cartelle dei dati SENTINEL sono molto estesi. Dato che il sistema operativo Windows ha 
difficoltà nel gestire file con nomi troppo lunghi, è consigliabile spostare il dato 
S2A_OPER_PRD_MSIL1C_PDMC_20160702T171833_R079_V20160702T095806_20160702T095806.SAFE 
facendo in modo che il percorso finale del file sia breve (ad esempio in C:\). In alternativa è possibile utilizzare la 
funzionalità “Map as drive” di Windows.  

 

Indice SR (Simple Ratio) per SENTINEL-2A 
 

E’ il più semplice indice di vegetazione in letterature. Assume valori tra 0 e infinito, in particolare tra 0 e 1 per i 
suoli e tra 6 e 10 per la vegetazione verde. 

RED

NIR
SR   

 

dove NIR e RED corrispondono ai valori nelle banda del vicino infrarosso (NIR) e nella banda del rosso (RED). 
Per i dati SENTINEL 2A queste due bande corrispondono alla banda B4 e B8.  
ERDAS IMAGINE 2016 dispone di una funzionalità di lettura diretta del formato *.SAFE e permette di ottenere, 
con pochi click, un unico raster dell’intera scena. 
 

 Cliccare con il tasto destro su 2D View e quindi su Open Raster Layer; 
 

http://www.esa.int/Our_Activities/Observing_the_Earth/Copernicus/Sentinel-2
https://support.microsoft.com/en-us/products/windows
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 Si aprirà la finestra Select Layer to Add; 
 

 
 
 

 Seleziona la cartella in cui sono presenenti i dati del dataset associato al tutorial. Dal menù a tendina 
Files of Type seleziona il formato SENTINEL2 (S2A_*.SAFE) e quindi seleziona il file  
 
S2A_OPER_PRD_MSIL1C_PDMC_20160702T171833_R079_V20160702T095806_20160702T09580
6.SAFE 
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 A questo punto bisogna cliccare sul tab Sub Images. Si aprirà la seguente finestra: 
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 Selezionando una delle varie opzioni presenti nella finestra Sub-Images è possibile importare: 
 

 Tutte le 13 bande ad una risoluzione geometrica di 10m (con ricampionamento di alcune 
bande); 

 Tutte le 13 bande ad una risoluzione geometrica di 20m (con ricampionamento di alcune 
bande); 

 Tutte le 13 bande ad una risoluzione geometrica di 60m (con ricampionamento di alcune 
bande); 

 Solo le bande B2, B3, B4, B8 (risoluzione geometrica pari a 10m); 

 Solo le bande B5, B6, B7, B8a, B11, B12 (risoluzione geometrica pari a 20m); 

 Solo le bande B1, B9, B10 (risoluzione geometrica pari a 60m). 
 
 
 Selezionare solo le bande con risoluzione geometrica pari a 10m. 
 

 
 
 
 Cliccare su OK. 

 
 In ERDAS IMAGINE verrà caricata l’immagine contenente 4 bande: 
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 Ulteriori dettagli sul dato importato è possibile ricavarli cliccando, nel tab Home, su Metadata> 

View/Edit Image Metadata 
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 Si aprirà la finestra Image Metadata, che mostra tutti i metadati relativi al dato importato. Come è 
possibile dedurre dalla finestra le 4 bande sono state importate in quest’ordine: B2, B3, B4, B8. 

 

 
 

 
 Per l’utilizzo del dato Sentinel-2A nello Spatial Modeler è importante ricordare l’ordine in cui le bande 

vengono caricate in ERDAS IMAGINE. Per il dato selezionato la banda del rosso e del vicino infrarosso 
sono identificabili in questo modo: 
 

o Banda rosso B4 =  banda 3 
o Banda vicino infrarosso NIR B8 = banda 4 

 
Dove i numeri 3 e 4 fanno riferimento all’ordine in cui le bande sono state imporate in ERDAS IMAGINE 

 
 Accedere allo Spatial Modeler da File > New > Spatial Model Editor 

Comparirà la seguente finestra: 
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 Dalla finestra Operators cliccare su Input > Raster e selezionare l’operatore Raster Input; 
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 Cliccare sull’operatore e trascinarlo nell’editor Panel (spazio bianco a quadretti): 
 

 

 

 L’operatore Raster Input è utilizzato per importare nel modello un’immagine raster da un file salvato sul 
pc. Tramite questo operatore viene quindi definito l’input del modello. L’opertore è dotato di una porta di 
input (Filename) e due porte di Output (RasterOut, AttributeTable). 
 

 

 Eseguire un doppio click sulla porta Filename e in seguito, nella finestra che compare dal menù a tendina 
Files of Type, selezionare il formato SENTINEL2 (S2A_*.SAFE) e quindi selezionare il file  
 
S2A_OPER_PRD_MSIL1C_PDMC_20160702T171833_R079_V20160702T095806_20160702T09580
6.SAFE 
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 A questo punto cliccare sul tab Sub Images e selezionare solo le bande con risoluzione geometrica 

pari a 10m. 
 

 
 
 
 Cliccare su OK. Come è possibile notare, la procedura è identica a quella eseguita in predecedenza per 

importare il dato nella finestra 2D di ERDAS IMAGINE. 
 

 Nel tab Operators cliccare sulla categoria Data Generation e trascinare l’operatore Band Selection 
nell’editor tab (spazio bianco a quadretti). 
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 In alternativa per cercare rapidamente un operatore è possibile scriverne il nome nel campo Search 
 

                            
 
 L’operatore Band Selection fornisce in output due o più bande del raster in ingresso (RasterIn). La porta 

BandRange permette di definire quali bande selezionare. La tabella di seguito permette di capire con 
maggiore chiarezza il funzionamento dell’operatore. 
 

 
 
 

Stringa inserita in 
BandRange 

Bande in uscita 

1 La prima banda del raster in ingresso 

1:3 Le bande 1,2,3 

4:2 Le bande 4,3,2 

1,1:2,5,9:7 1,1 (ripetuta), 2, 5, 9, 8 , 6 
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 In questo caso per il calcolo dell’indice NR servono la banda 3 (Banda Rosso) e la banda 4 (Banda del 
vicino Infrarosso). Per poter eseguire i calcoli richiesti è necessario “separare” le due bande, per questo 
motivo verranno utilizzati due operatori Band Selection; 
 

 Cliccare con il tasto destro sull’operatore Band Selection e quindi cliccare su Copy (o in alternativa 
CTRL+C); 
 

 Cliccare con il tasto destro in un punto a caso, nell’editor Panel, e in seguito cliccare su Paste (CTRL+V); 

 

 

 

  Cliccare una volta sull’operatore Band Selection posto in alto. L’operatore selezionato cambierà 
colore, da verde a blu. Ora è possibile modificarlo. 

 

 Cliccare con il tasto destro sull’operatore selezionato e Rename per rinominare l’operatore con il nome 
‘RED BAND’. 
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 Sempre selezionando l’operatore RED BAND, configuriamo la porta BandRange inserendo il valore 3 
nel campo “Value” nella tabella Operator Properties presente in basso a destra. 
 

 

 

  Adesso è possibile collegare la porta RasterOut  dell’operatore Raster Input con la porta RasterIn 
dell’operatore RED BAND. Per collegare due porte è sufficiente cliccare sulla porta di partenza e, 
tenendo premuto il mouse, collegarsi all’altra. 
 
 

 

 
  Configurare il secondo operatore Band Selection replicando quanto fatto con il primo e nominandolo 

“NIR BAND”. Inserire per la porta Band Range il valore 4. 
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  Dalla tab Operators cliccare sulla categoria Math & Trig trascinare l’operatore Divide nell’ambiente di 
modellazione. 
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L’operatore fornisce in Output il risultato del rapport Input1/Input2 e supporta i seguenti dati: 

 

 

 Come è possibile dedurre dalla tabella per ottenere in output un dato in formato Float (numeri con la 
virgola) è necessario fornire in input due input nel formato Float.  
Dato che bisogna ottenere l’indice NR nel formato Float (con la virgola) utilizziamo, a valle degli operatori 
Band Selection l’’operatore Float. 
 

 Tale operatore è disponibile nella categoria Data Generation (per cercare rapidamente un operatore è 
possibile utilizzare il campo ricerca nel panel Operators) 

 

 

 Collegare gli operatori come di seguito: 
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 Per poter visualizzare una preview dell’indice calcolato, è possibile utilizzare l’operatore Preview. 
Utilizzare il campo Search scrivendo ‘preview’: come è possibile vedere lo stesso operatore può essere 
presente anche in due differenti categorie. 
 

 

 

  Collegare l’operatore Preview alla porta di Output dell’operatore Divide. 

 

 

 

 Cliccando sul tool Preview, nella toolbar Spatial Model Editor, è possibile visualizzare la preview 
dell’indice NR calcolato. 
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 Per poter salvare il risultato in un raster di output è necessario utilizzare l’operatore Raster Output 

 

       

 Collegare l’operatore come di seguito: 
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 Cliccare sulla porta FilenameIn e selezionare nome e destinazione del file da salvare: nominare il file 
indice_sr.img. Cliccare sulla porta PixelType e selezionare Float32.  

 

 

 
  Cliccare su Run > Run dalla Spatial Model Toolbar per lanciare il processamento e salvare il file.  
 
 

NOTA. Dato che il dato Sentinel-2 utilizzato è molto pesante, l’esecuzione di questo passaggio potrebbe 
richiedere un po’ di tempo. Di seguito nel tutorial verrà presentato un modello che permette di rendere 
più rapido il processamento lavorando su aree più ristrette. 
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 E’ possibile visualizzare il risultato aprendo il file salvato in una nuova finestra 2D. E’ anche possibile 
visualizzare il valore dell’indice NR nei vari punti del raster utilizzando il tool Inquire, disponibile nel tab 
Home. 
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 A questo punto è possibile tornare nello Spatial Modeler Editor e salvare il modello cliccando su File > 
Save > Spatial Model 
 

 Si aprirà una finestra per definire nome e destinazione del file modello da salvare. Il modello creato avrà 
estensione *.gmdx. Denominare il modello ‘indice_sr’. 
 

 
 

 Chiudere lo Spatial Modeler Editor; 
 

 

 

 

  



 

GEOXPERIENCE ACCADEMY - HEXAGON GEOSPATIAL SOFTWARE 

 23 

PK01-528-579 

Indice NDVI per SENTINEL-2A 
 

L’Indice NDVI (Normalized Difference Vegetation Index) sfrutta la diversa risposta della copertura vegetale alle 
bande spettrali del visibile (rosso) e del vicino infrarosso (NIR) fornendo un valore numerico adimensionale, 
secondl la formula: 

REDNIR

REDNIR
NDVI






 

dove NIR e RED corrispondono ai valori di radianza nelle banda del vicino infrarosso e nella banda del rosso. Per 
i dati SENTINEL 2 queste due bande corrispondono alla banda B4 e B8. 

L’indice NDVI è teoricamente compreso tra -1 e +1. Tale valore è stato dimostrato essere in stretta relazione con 
lo stato di salute della vegetazione, intesa come biomassa e area fogliare ed ai processi biochimici ad essa 
correlati (attività fotosintetica).  

 Il modello per il calcolo dell’indice NDVI sarà realizzato modificando il modello precedente. Per riaprire il 
modello salvato in precedenza è necessario cliccare su New>Spatial Model Editor 

 

 

  Cliccare con il tasto destro nell’ambiente di modellazione (Editor Panel) e selezionare Open 
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 Selezionare il file indice_sr.gmdx e cliccare su OK. 
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 In Operators > Math & Trig selezionare l’operatore Subtract 
 

 

 

 Modificare il modello precedente e collegare gli operatori in questo modo: 
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 Per spostare più operatori contemporaneamente è necessario selezionarli (nell’immagine precedente i 
tre operatori a destra sono selezionati, la procedura per la selezione è simile a quella dei file nelle cartelle 
di Windows) 

 

 In Operators >Math & Trig selezionare l’operatore Add 
 

 

 Modificare il modello precedente e collegare gli operatori in questo modo: 
 

 

 

 Cliccare sulla porta FilenameIn (nell’immagine in alto dove c’è sr.img) dell’operatore Raster Output e 
selezionare nome e destinazione del nuovo file. Chiamare il file in output ‘indice_ndvi’. 
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 Salvare il modello con il nome NDVI.gmdx 
 
 Cliccando sul tool Preview, nella toolbar Spatial Model Editor, è possibile visualizzare la preview 

dell’indice calcolato. 
 
 Cliccare su Run > Run dalla Spatial Model Toolbar per lanciare il processamento e salvare il file. 

 
 Ora è possibile visualizzare il risultato aprendo il file salvato in una nuova finestra 2D. E’ anche possibile 

visualizzare il valore dell’indice NDVI nei vari punti del raster utilizzando il tool Inquire, disponibile nel tab 
Home. 
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Trasformazione di un modello in un pulsante personalizzato di 
ERDAS IMAGINE 
 

Mediante l’utilizzo di alcuni operatori particolari, denominati ‘porte’ è possibile creare con estrema facilità una 
semplice GUI (interfaccia grafica) di un modello e trasformarlo in un tool personalizzato di ERDAS IMAGINE, al 
quale poter associare un’icona nella toolbar del software. 

 

 Aprire nuovamento il modello indice_ndvi.gmdx realizzato in precedenza. 
 

 Agendo nel pannello degli operatori, ricercare l’operatore “Port” e aggiungere al modello due  operatori 
Port Input 

 

 

 

https://it.wikipedia.org/wiki/Interfaccia_grafica
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 Collegare gli operatori Port Input in questo modo: 

 

 

 Selezionare l’operatore Port Input 1 e rinominarlo Sentinel_4_Bands_10 m 
 Selezionare l’operatore Port Input 2 e rinominarlo NDVI; 
 

 
 

 Cliccando su Run o su Preview per lanciare o vedere una preview del modello, verrà automaticamente 
aperta la seguente fienestra: 
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E’ possibile riconoscere nei nomi dei due campi presenti nella finestra i nomi delle due porte 
aggiunte in precedenza: in termini di output ottenuti dal modello non cambia niente, utilizzando le porte 
cambia il modo in cui l’utilizzatore deve inserire i dati di input nel modello. 

 
 
 Cliccare in un punto qualsiasi dell’Editor Panel (spazio bianco dove è presente il modello), in modo da 

non selezionare nessun operatore e posizionarsi con il mouse, in basso a destra nel panel Operator Info.  
 

  
 

 Nel pannello Operato Info, quando non è selezionato alcun operatore, possono essere definite alcune 
proprietà dell’intero modello: nome, icona (file *.ico), ecc. Quando invece è selezionato un solo operatore 
si modificano le informazioni solo dell’operatore selezionato. 

 

 In corrispondenza del primo campo Display scrivere “Sentinel NDVI”, in corrispondenza del campo Icon 
(*.ico) selezionare il file Sentinel2.ico presente nelle cartella 02_Modelli del dataset associato al tutorial. 
Nel campo Description scrivere ‘Indice NDVI per dati SENTINEL2’. 
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 Cliccare in un punto qualsiasi dell’Editor Panel (spazio bianco dove è presente il modello), in modo da 
non selezionare nessun operatore e posizionarsi con il mouse sul panel Properties. Cancellare eventuali 
stringhe presenti nel campo “Value” 
 

            

 

 Salvare il modello File > Save > Save Spatial Model 
 
 Nella toolbar cliccare sul comando Add To My Models 
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 Si aprirà la seguente finestra mediante la quale è possibile eventulamente apportare qualche modifica 

alle info associate al modello. Clicca su OK. 
 

 
 
 Automaticamente verrà aggiunta nell’interfaccia di ERDAS IMAGINE un tab denominato MyModels in 

cui è presente il pulsante associato al modello NDVI creato 
 

 

 Chiudere la finestra Spatial Model Editor; 
 
 Cliccando sul nuovo pulsante creato il modello verrà lanciato: 
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 Come è possibile notare è possibile modificare il modello (cliccando su Edit), visualizzare una preview 

o lanciarlo per elaborare una singola immagini (cliccando su Run) o per elaborare più immagini alla 
volta (cliccando su Batch). 
 

 Cliccare su File > Layout > Save Layout as Default per salvare in modo definitivo le modifiche effettuate 
all’interfaccia del software. 
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Utilizzo guidato di alcuni modelli più evoluti 
 

Modello per il subset di un dato Sentinel-2A su di un’area di interesse 
 

Le immagini Sentinel-2 hanno uno swath molto ampio (290 km), per cui può essere utile in alcune circostanze 
estrarre dall’intera scena solo una piccola porzione di interesse. Può essere ad esempio il caso di un monitoraggio 
eseguito all’interno di un territorio comunale, per il quale l’area di interesse può essere rappresentata dai confini 
amministrativi. 
In questa parte del tutorial verrà utilizzato un modello, realizzato dai tecnici di Planetek Italia, che permette di 
estrarre dal file .SAFE dell’intera scena Sentinel 2A solo una zona di interesse, definita mediante uno shapefile. 
Il tool è fornito con il dataset associato a questo tutorial, nella cartella 02_Modelli e si chiama 
‘Sentinel_Subset.gmdx’ 

Per questa parte del tutorial verrà utilizzato il dato: 

S2A_OPER_PRD_MSIL1C_PDMC_20160702T171833_R079_V20160702T095806_20160702T095806.SAFE  

disponibile nella cartella 01_SENTINEL_2 del dataset associato al tutorial. 

I nomi dei file e delle cartelle dei dati SENTINEL sono molto estesi. Dato che il sistema operativo Windows ha 
difficoltà nel gestire file con nomi troppo lunghi, è consigliabile spostare il dato 
S2A_OPER_PRD_MSIL1C_PDMC_20160702T171833_R079_V20160702T095806_20160702T095806.SAFE 
facendo in modo che il percorso finale del file sia breve (ad esempio in C:\). In alternativa è possibile utilizzare la 
funzionalità “Map as drive” di Windows. 

 

 

 
 Per lanciare il tool dal tab Toolbox cliccare Spatial Model Editor > Launch Spatial Model 

http://www.planetek.it/prodotti/tutti_i_prodotti/erdas_imagine
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 Selezionare il file Sentinel_Subset.gmdx e cliccare su OK; 
 Si aprirà la finestra Spatial Model: 

 
 

 

 

 Nel campo Sentinel2_SAFE selezionare il file .SAFE (Sentinel-2) da utilizzare. Per questo tutorial 
utilizzare il file  
 
S2A_OPER_PRD_MSIL1C_PDMC_20160702T171833_R079_V20160702T095806_20160702T09580
6.SAFE.   
 
Prima di selezionare il file .SAFE assicurarsi che nel menù a tendina Files of Type sia selezionato 
Sentinel-2 (S2A_SAFE). Non aprire il tab Sub-Images. 
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 Nel campo Directory Output definire la cartella in cui salvare i dati in output. Per definire correttamente 
la cartella di output bisogna entrare nella cartella in cui si desiderano salvare gli output e cliccare su OK, 
non scrivendo nulla nel campo directory. 
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 Nel campo Input Geometry (*.shp) selezionare il file vettoriale da utilizzare per l’individuazione dell’area 
di interesse. Per questo tutorial verrà utilizzato lo shapefile con tutti i limiti amministrativi dei comuni italiani 
relativo al 2015, scaricato dal sito dell’ISTAT e disponibile nel dataset associato al tutorial, nella cartella 
03_Vettoriali : Com2015_WGS84.shp 

 

 

 Nel campo Attribute Query è possibile definire una query per individuare all’interno dello caricato una o 
più geometrie (comuni) di interesse. Per questo tutorial, ad esempio, verrà selezionata solo la feature 
relativa al Comune di Trani, scrivendo nel campo Attribute Query: COMUNE='Trani' 

 

http://www.istat.it/it/archivio/124086
http://www.comune.trani.bt.it/
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 Cliccare su OK; 
 
 Al termine del processamento nella cartella indicata come cartella di output saranno disponibili tre file 

*.img (con il rispettivo file *.rrd delle piramidi). 

 

 

 
 Questi tre file .img rappresentano tre “stack” differenti che raggruppano le bande di Sentinel2-A aventi 

una risoluzione geometrica pari a 10m, 20m e 60 m, rispettivamente. Visualizzando questi dati in una 
vista 2D è possibile constatare che i tre file interessano solo l’area definita dai limiti amministrativi del 
comune di Trani: 
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Modelli pronti disponibili in ERDAS IMAGINE 
 

In ERDAS IMAGINE sono disponibili diversi modelli già realizzati che è possibille utilizzare, modificare e 
personalizzare. Di seguito verranno descritti alcuni esempi pratici e verranno mostrati diversi stratagemmi per 
individuare modelli già pronti da poter modificare. 

 

Indices Models: tutti gli indici della libreria Hexagon  
 

 Caricare in una finestra 2D l’immagine Sentinel-2A  
S2A_OPER_PRD_MSIL1C_PDMC_20160702T171833_R079_V20160702T095806_20160702T09580
6.SAFE 
 
Il dato è disponibile nella cartella 01_Sentinel2 
 

 Cliccare nel tab Raster > Unsupervised > Indices 
 

 
 
 Si aprirà la seguente finestra: 
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 Nel Menu Index selezionare l’indice MSAVI2: 

 

https://hexagongeospatial.fluidtopics.net/book#!book;uri=5d68e1db557af5bab494d96c7f8e1a9d;breadcrumb=be4e36518f3b39883b1633b55928207b-66b7ed11ed0fc42bcd589e2800595fda-d4385edad10647db99967ee27198873f
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 Cliccare su Preview. Verrà visualizzata la preview dell’indice. 
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 Chiudere la preview. Nella finestra Indices cliccare sul tasto View. 
 

 
 

 Verrà aperta una finestra dello Spatial Model Editor in cui verrà caricato automaticamente il modello 
corrispodente all’indice  MSAVI2.  
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 E’ possibile salvare il modello in un nuovo file (File> Save > Spatial Model). Il modello salvato può 

essere modificato e personalizzato. 
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Graphical Models: i modelli del Model Maker 
 

In ERDAS IMAGINE, prima dell’esistenza dello Spatial Modeler,  era utilizzato un altro strumento di modellazione 
grafica, denominato Model Maker. Il Model Maker, ancorda oggi disponibile in ERDAS IMAGINE, aveva alcuni 
aspetti in comune con lo Spatial Modeler, ma per gli algoritmi più complessi richiedeva l’utilizzo di un linguaggio 
proprietario, chiamato ERDAS SML. Molti dei tool disponibili in ERDAS IMAGINE sono stati costruiti con il Model 
Maker e, in moltissimi casi, è possibile accedere al modello originale. Di seguito il tutorial descriverà come è 
possibile individuare questi modelli, aprirli e modificarli nel nuovo Spatial Modeler. 

 

 Nel Tab Raster cliccare su Spectral > Principal Component 
 

 
 
 Si aprirà la finestra Principal Components che permette di utilizzare il tool per l’analisi alle componenti 

principali nel modo tradizionale (mediante GUI). 
 

https://hexagongeospatial.fluidtopics.net/book#!book;uri=fb4350968f8f8b57984ae66bba04c48d;breadcrumb=4f2963009f6186adf0489c2dd7f0191b-fa45ecf661b0f7b2a1d187710d61fa23-c3ea7534472c36d9dfadb4d9e80e547f
https://hexagongeospatial.fluidtopics.net/book#!book;uri=732f83375e04667b4d4948636d32c63b;breadcrumb=4f2963009f6186adf0489c2dd7f0191b-8dc9c0601888f830277261738d43c66b-f0d635568a2004855485002f297539cd
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 Cliccando sul tasto View si aprirà la finestra del Model Maker in cui è presente il modello. 
 

 
 

 Per utilizzare il modello nella più semplice interfaccia del nuovo Spatial Modeler cliccare su File > Save 
As 
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 Salvare il file in una cartella a scelta con il nome ‘principal_components’ 
 

 
 

 Da notare che il file salvato ha estensione *.gmd (i modelli creati con il nuovo Spatial Modeler hanno 
estensione *.gmdx).  
 

 Per utilizzare il file nello Spatial Modeler cliccare su File > New Spatial Modeler Editor. Nell’Editor 
Panel cliccare con il tasto destro e quindi su Open. 
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 Nella finestra che compare, selezionare dal menù a tendina Files of Type selezionare Graphical Model 

(*.gmd). Posizionarsi nella cartella in cui è stato salvato il file principal_components.gmd in precedenza 
ed aprire il file. 
 

 



 

GEOXPERIENCE ACCADEMY - HEXAGON GEOSPATIAL SOFTWARE 

 49 

PK01-528-579 

 

 Il modello verrà aperto nello Spatial Model Editor: 
 

 
 
 E’ possibile modificarlo e salvarlo nel formato *.gmdx 
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Dove sono nascosti tutti i modelli di ERDAS IMAGINE 
 

Come analizzato negli esempi precedenti, ogni qual volta che nelll’interfaccia principale di un tool di ERDAS 
IMAGINE è presente il tasto “View” è possibile visualizzare il modello alla base del tool stesso. Il modello può 
essere disponibile in un file *.gmd (graphical models del Model Maker) o file *.gmdx (nuovi modelli dello Spatial 
Modeler).  
La maggior parte dei file *.gmd e *.gmdx, nel momento in cui ERDAS IMAGINE viene installato, vengono salvati 
nella cartella  
 
C:\Program Files\Hexagon\ERDAS IMAGINE 2016\etc\models 
 
 
Per non compromettere il normale funzionamento di ERDAS IMAGINE è opportune non modificare 
direttamente i modelli presenti nella cartella sopra indicata, ma lavorare sempre su delle copie. 
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Modelli pronti scaricabili gratuitamente dal web 
 

Sulla rete sono disponibili tantissimi modelli dello Spatial Modeler (file *.gmdx) scaricabili gratuitamente dal sito 
della Hexagon Geospatial o di alcune aziende partner. Di seguito i link più importanti: 

 

 Hexagon Geospatial Spatial Models 
http://community.hexagongeospatial.com/t5/tkb/v2/page/blog-id/KS_SpatialModeler_AnalyticalRecipes 
 

 Sterling GEO LIBRARY 
http://www.sterlinggeo.com/spatial-modeler-library-index/ 
 

 Planetek Italia Library 

Cooming Soon! 
 

 User Submitted Models 
http://e2b.erdas.com/service/support/SpatialModels/Spatial_Models.aspx 
 

 Hexagon Geospatial Community 
http://community.hexagongeospatial.com/t5/Discussions/ct-p/Discussions 
 
 

 

Altre risorse didattiche 
 

 Video-corsi sullo Spatial Modeler: 

http://community.hexagongeospatial.com/t5/IMAGINE-Spatial-Modeler/tkb-p/eTSpatialModeler 
 
 Blog Hexagon Geospatial: 

http://blog.hexagongeospatial.com/tag/spatial-modeler/ 
 
 Blog Geospatial News Planetek Italia: 

http://geospatialnews.planetek.it/ 
 
 
 

 

  

http://www.hexagongeospatial.com/
http://community.hexagongeospatial.com/t5/tkb/v2/page/blog-id/KS_SpatialModeler_AnalyticalRecipes
http://community.hexagongeospatial.com/t5/tkb/v2/page/blog-id/KS_SpatialModeler_AnalyticalRecipes
http://www.sterlinggeo.com/spatial-modeler-library-index/
http://www.sterlinggeo.com/spatial-modeler-library-index/
http://e2b.erdas.com/service/support/SpatialModels/Spatial_Models.aspx
http://e2b.erdas.com/service/support/SpatialModels/Spatial_Models.aspx
http://community.hexagongeospatial.com/t5/Discussions/ct-p/Discussions
http://community.hexagongeospatial.com/t5/IMAGINE-Spatial-Modeler/tkb-p/eTSpatialModeler
http://blog.hexagongeospatial.com/tag/spatial-modeler/
http://blog.hexagongeospatial.com/tag/spatial-modeler/
http://geospatialnews.planetek.it/
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Chi è Hexagon Geospatial 
Hexagon Geospatial aiuta a dare un senso ad un mondo che cambia dinamicamente.  Conosciuti a livello 
mondiale come leader nella produzione di tecnologie avanzate, supportiamo i nostri clienti nel trasformare 
facilmente i loro dati in informazioni, accorciando il ciclo di vita dal momento del cambiamento all’azione. Hexagon 
Geospatial offre prodotti software e piattaforme per una vasta gamma di clienti attraverso la vendita diretta, 
partners, e  imprese, compresa la tecnologia geospaziale di base per guidare Intergraph® Security, Government 
& Infrastructure (SG&I) soluzioni per l'industria. Hexagon Geospatial è una divisione di Intergraph Corporation. 
Per ulteriori informazioni, visitare il sito www.hexagongeospatial.com.  

Intergraph Corporation è parte di Hexagon (Nordic scambio: HEXA B). Hexagon è un fornitore leader globale di 
tecnologie di progettazione, misura e visualizzazione che consente ai clienti di progettare, misurare e posizionare 
oggetti, e di processo e dei dati presenti. 

Per saperne di più www.hexagon.com.  

Chi è Planetek Italia 
Planetek Italia è uno dei principali operatori nazionali nel settore dell’informatica applicata alla gestione territoriale, 
che offre consulenza multi-disciplinare per lo sviluppo di Sistemi di Informazione Geografica (GIS) e di 
Osservazione della Terra (E.O.). L’azienda è attiva nello sviluppo di soluzioni informatiche per l’archiviazione, 
elaborazione e distribuzione di banche dati cartografiche e immagini telerilevate da satellite, nella realizzazione 
e commercializzazione di prodotti software, e nell’erogazione di servizi di consulenza e formazione.  
Planetek Italia è distributore per l’Italia dei software Hexagon Geospatial, fornitore di dati telerilevati da satellite, 
e centro di formazione ed addestramento all’utilizzo degli strumenti software inclusi nel Power Portfolio. 

Per saperne di più www.planetek.it.  
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